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PURPOSE
This document establishes basic format and style conventions for letters the Office of
New Animal Drug Evaluation (ONADE) issues to sponsors and other outside parties.

II.

STANDING AND IMPACT OF OUR LETTERS
Our letters are part of official government records and, as such, need to ensure
adequate and proper documentation of our decisions and transactions.
Our letters also can have significant impacts on their recipients. Based on their
understanding of our letters, sponsors may make decisions to reallocate the sponsor’s
priorities, time, money, and effort to serve the needs of the company. Therefore, we
should issue letters that clearly and precisely convey our decisions on particular
issues.

III.

FORMAT AND STYLE CONVENTIONS
A written letter is our principal and preferred form for communicating information to
sponsors or other outside parties. These letters document our decisions as they relate
to particular issues. Adhering to a set of format and style conventions increases the
consistency in the quality and appearance of our letters.
Experts have published style manuals presenting their particular preferred format and
style conventions for writing letters. These preferred styles and conventions are not
entirely consistent, nor do they remain static over time. The preferred set of
conventions and styles we have adopted in this document consider several experts’
sets of styles and conventions, our past practices, and our need for clarity and
consistency in the letters we issue.
If we have developed a template for a particular type of letter, use it. If no other
ONADE letter template exists, use the Acknowledgment letter template so that your
letter is consistent with the styles and conventions presented in this document.
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A. Copies of letters
Prepare the electronic file for the letter. If the letter pertains to multiple
submissions within a single administrative file (i.e., INAD file, NADA file, etc.), or
if the letter pertains to multiple administrative files, you may write a single letter
to cover all submissions. However, when closing the submission out in Appian,
upload an electronic file for each administrative file. Unless the submissions are
linked in our Submission Tracking and Reporting System (STARS), see P&P
1243.3030 for more information.
B. Margins
Use the following margins on all letters: all margins (i.e., left; right, top, and
bottom margins) should be 1 inch.
C. Fonts
Use Verdana (10 point) as the principal font family. The predominant font style
you should use is “regular.” You may use italic and bold styles judiciously for
emphasis and clarity. You may also use other font effects such as underline,
CAPITALIZATION, and SMALL CAPITALIZATION sparingly. The overuse of font styles
and effects can compromise clarity. You should not manually adjust the spacing
between characters (i.e., kern fonts).
When you need to use Greek, and similar, characters, you should insert them
using the Symbol font (10 point). You should use Microsoft Equation or the
MathType plug-in for Microsoft Word for statistical equations and similar uses.
D. 508 compliance
Review and Submission summary documents should be created in a manner that
conforms to Section 508 of the Rehabilitation Act.
E. Headers
Letters exceeding one page in length should have a right-justified 10-point header
beginning 0.5 inches from the top paper edge. This header should be visible on
the second and subsequent pages. 1 Typically, the header consists of the principal
submission identification, e.g., I-012345-P-0123-EF, on the first line and a “Page
x” entry on the second line.
Example:
I-012345-P-0123-EF
Page 2

1

To format the header, click on “Page Setup” from the “File” menu of Microsoft Word, select the “Layout” tab,
check the “Different first page” box, and set the “Header” to 0.5 inches from the edge.
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If the letter addresses two principal submissions from one document or one
submission from each of two documents, use two lines to identify the principal
submissions.
Example:
I-012345-G-0100-OT
I-013001-G-0004-OT
Page 2
If the letter addresses three or more principal submissions, the first line should
identify only the first submission listed in the principal submission identifier field
followed by the phrase “et al.” to indicate the additional submissions.
Example:
N-012635-C-0100-OT, et al.
Page 2
Where the letter does not address a submission, the first line of the header should
be the content of the reference (“Re:”) line.
Example:
Reference line text here
Page 2
F. Principal submission identification field
This field identifies the principal submission(s) to which this letter responds.
Amending submissions, or other submissions that provide ancillary or supporting
information, are not principal submissions and thus are not identified here. The
identification of a principal submission consists of the one uppercase letter
designation of the document type, the 6-digit document number, the one
uppercase letter designation of the submission type, the 4-digit submission
number, and the two uppercase letter subclass code, separated by dashes.
This field is the top-most text placed on the first page. It begins at the left margin
on a line that is no less than 0.75 inches below the top margin of 1 inch. When a
one-page letter is brief, you can begin the letter by placing this field further down
the page to “center” the letter on the page visually.
If the letter addresses an issue that applies to a group of principal submissions,
include identification of all principal submissions in this field. The display order of
multiple principal submissions is determined by sequentially alphabetizing by
document type, placing in numerical order by document number within document
type, and, if necessary, placing in numerical order by submission number within a
document.
•

If the multiple submissions include linked submissions, then display the
lead submission (that is identified by an L in STARS) first, regardless of
document type, document number, or submission number followed by the
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linked submissions (identified with an asterisk in STARS) using the display
order described above. (See P&P 1243.3030 Completing Final Action
Packages for STARS Submissions for a definition of linked submissions and
the administrative process to be followed).
•

For a letter that addresses two principal submissions, list the submissions
on consecutive lines using the display order indicated above.

•

If the letter addresses three or more principal submissions, create a multirow three-column (of equal width spanning the text area (6.25”)) table
that is sufficiently large to capture all principal submissions. Fill the table
cells using the display order in a “top to bottom” order within a column and
“left to right” by columns. Set the format of the table borders to “None”. 2
Left-justify the table cell contents.

Examples:
I-012345-G-0011-OT
N-141141-G-0234-OT

N-100635-C-0100-OT
N-101314-C-0098-OT
N-101315-C-0097-OT

N-113645-C-0101-OT
N-123045-C-0100-OT
N-141013-C-0088-OT

N-141068-C-0052-OT
N-141071-C-0027-OT

G. Inside address
Direct the letter to the attention of the responsible official (sponsor or other party
on the sponsor’s behalf 3) who signed the Form 356v of the paper submission or is
named as the contact in the Responsible Official Information section of the
eSubmitter form. Use the firm name and address provided for the responsible
official in the Responsible Official Information section of the e-Submitter form or
the Form 356v for scanned paper submissions. However, if you find obvious
typographical (i.e., spelling) errors in either the firm name, firm address or
responsible official information, you should use the correct information in the
inside address instead of using the incorrect information from the form.
Additionally, if the firm name in the Responsible Official Information section of the
eSubmitter form (or for paper submissions, in the cover letter) appears to be
incorrect or is unclear regarding the identity of the drug application sponsor (for
example, if the firm name is written in the eSubmitter form or cover letter as
“Drug Company Animal Health” and the firm name listed in 21 CFR 510.600 is
2

To set the table borders to “None” in Microsoft Word, select the table (by dragging to highlight the table, clicking
in the table and then on the “table square” near the top left of the table, or clicking in the table and then clicking
(in succession) “Table” on the “Tools” menu, “Select” from the drop-down menu, and then “Table” in the secondary
menu). Once the table is selected, click “Format” on the “Tools” menu, click “Borders and shading” from the dropdown menu, click the “Borders” tab, click the “None” setting, and accept the command by clicking the “OK” button
or pressing the “Return” key.
3
Examples of when it is acceptable for a submission to be sent to us by another party on the sponsor’s behalf: 1)
the company is not a United States company, they will have U.S. Agent; 2) correspondence may come from
consultants; 3) a parent company submits information on a subsidiary’s behalf.
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“Drug Company Animal Health, a Division of Drug Company Inc.”), contact the
responsible official to obtain the correct name. Note in your review documentation
that you contacted the sponsor to clarify the information, and if applicable, make
note of the corrected name in your review documentation and in the Request for
QC Review form, and use the corrected name in the inside address.
You may also modify the stylistic presentation (capitalization, punctuation, and
spacing) of the firm name and the official’s name, titles, and degrees contained in
the form to match the addressee’s preference in the cover letter. However, do not
add information (e.g., degrees) if it is not in the information provided in the Form
356v or eSubmitter form. The inside address begins two blank lines below the
principal submission identification field.
Example:
Drug Company International
Attention: John Doe, DVM, PhD
Manager, Regulatory Affairs
1100 Industrial Drive, Suite 500
Anytown, NJ 55555
H. Reference line
The reference line should briefly (typically 3-8 words) identify the main topic of
the letter. The reference line begins one blank line below the inside address.
Example:
Re: Request for review of study protocol 2005-123abc-ver3b
I. Salutation
Example:
Dear Dr. Doe:
J. Body of the letter
You should not indent the first line of a paragraph. Each paragraph should begin
at the far left margin or, for subordinate paragraphs, at the new margin
established by the subordinate position of the paragraph. You should separate
paragraphs by one blank line.
1. First paragraph
The first sentence should convey our main decision regarding the issue
presented in the letter(s) to which we are responding. You should use the
remaining sentences of this paragraph to provide the supporting and limiting
information that place the main decision or action in the proper and accurate
context.
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2. Subsequent paragraphs
These paragraphs (if needed) should convey all other necessary information to
provide a complete response for the letter to which we are responding. 4 What
constitutes a complete response may vary with the type and quality of the
letter or submission.
3. Closing paragraph
The final paragraph politely ends the letter. You should include a sentence
instructing the recipient to refer to the date and the principal submission
identification field found at the top of our letter when submitting
correspondence relating to our letter. You should also identify an individual the
addressee can contact for further information. If the contact is the individual
who signs the letter, include his or her telephone number and email address. If
the contact is someone other that the individual who signs the letter or
multiple points of contact, identify the individual(s) by name, organizational
title, and provide their telephone number and email address.
K. Complimentary closing and signature block
Use “Sincerely,” as the complimentary closing. The closing begins one blank line
below the closing paragraph.
The content of the signature block should conform to that established for the
individual signing the letter. The first line of the signature block should begin three
blank lines below the closing.
Indent the closing and signature block 3 inches from the left margin.
Example:
Sincerely,
{see appended electronic signature
page}
Matthew A. Lucia, D.V.M.
Director
Office of New Animal Drug
Evaluation
L. Enclosure notation
Insert the enclosure notation only if additional items are included with the
response to the sponsor. The enclosure information begins at the left margin two
blank lines below the bottom of the signature block. The first line is “Enclosure:”
4

A complete response means that we have addressed the issues raised in the letter consistent with our regulations
and policies.
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(plural if more than one enclosure). The second and additional lines are brief
descriptions of the enclosures (one line per enclosure).
Example:
Enclosures:
Title (or brief description) of enclosure 1
Title (or brief description) of enclosure 2
All enclosures itemized in the letter should be included in the final action package
and designated as “send to firm” in Appian.
M. cc: block notation in issuing letters
Include a cc: block in an issuing letter to indicate that we are sending the letter to
other parties external to FDA. For example, include a cc: block notation in food
use authorization letters for terrestrial species, because USDA/FSIS gets a copy of
the letter. Internal (FDA) routings of the letter are never included in the cc: block
of the issuing letter.
The cc: block begins at the left margin two blank lines below the bottom of the
signature block.
Example:
cc:
Residue Staff, USDA/FSIS/PDD,
Edward Zorinsky Federal Building
1616 Capitol Avenue
Suite 260
Omaha, Nebraska 68102
IV.

WRITING WITH CLARITY
As discussed in section II, there are important reasons for you to prepare letters of
exceptional quality and clarity.
When you draft a letter, you should use plain language writing techniques. 5 For
example, use the active voice when possible and write at the level appropriate for
your audience. Writing at a level appropriate to your audience includes remembering
that they may not be as intimately versed in your area of expertise as you are, so you
should keep the use of technical acronyms and jargon to a minimum to clearly convey
your intended meaning. You may also find the use of the Graham methods of predrafting, drafting and editing of the letter helpful. 6 In addition, use the spell check
and grammar function of your word processor. Proofread the letter to catch any
errors that automated spell checking and grammar tests may not identify.

5
6

See http://www.plainlanguage.gov and http://www.archives.gov/federal-register/write/plain-language/.

See Graham, D.O. and J.H. Graham, 2002, The Writing System: A Step-by-Step Guide for Business and Technical
Writers, Preview Press, Fairfax, VA. If you have questions or need help with the procedures, contact the Quality
Assurance Team.
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V.

“CLEAN” ELECTRONIC FILES
Critically examine the electronic file of the letter to remove all traces of information
that are not part of the body of the file. All electronic files should be “clean”. 7

VI.

REFERENCES
Books
Graham, D.O. and J.H. Graham. 2002. The Writing System: A step-by-step guide
for business and technical writers, Preview Press, Fairfax, VA.
Plain language web sites
http://www.plainlanguage.gov
http://www.archives.gov/federal-register/write/plain-language/
CVM Program Policies and Procedure Manual
1240.2110 – Procedures for Resolving Scientific Data Disagreements within CVM
1243.3005 - Creating Clean Electronic Files
1243.3030 – Completing Final Action Packages for STARS Submissions

VII. VERSION HISTORY
May 24, 2005 – original version
July 1, 2005 – minor changes to content of concurrence table (section III.L.3)
September 4, 2007 – Changed to add subclass code to the submission identifier and
replace the preparer line with the Other Administrative Information box. Also
referencing the new P&P 1243.3005.
December 4, 2008 – Revised to clarify that the file copy of all letters and the file
copies of enclosures accompanying the letter are printed on pink paper. Removed
reference to 1243.3060 Final document routing and copy distribution, which no longer
exists.
October 14, 2011 – Revised to describe processes changed by implementation of
Appian and electronic finalling of review documentation.
October 7, 2015 - Revised to change all margins to 1.0” and remove Appendix 1
additional instructions for submissions received prior to March 14, 2011.
June 13, 2016 – Revised to current format, removed instruction to embed fonts, and
removed mention of submissions made prior to March 14, 2011.

7

See P&P 1243.3005 on how to create clean electronic files
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March 9, 2018 – Revised to clarify procedures regarding the inside address of the
letter.
August 1, 2018 – Revised Section III. F. to include instructions on how to reference
linked submissions. Also, updated information in the section on closing paragraphs to
instruct the preparer of the letter to include the email address of the point of
contact(s) identified in the closing paragraph.
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